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1 Description

Startup Diagnostics/maintenance Control system (PLC)
(DPM2) (DPM2) (DPM1)

The MSI-FB-PB100 is a module which allows the connec-
tion of the MSI XXX to the PROFIBUS-DP. The module is
certified in accordance with the DPV1 specification

(EN 50170).

You can find the GSD file (with the characteristic communi-
cation features of a PROFIBUS-DP device) online at
www.leuze.com/controller/.

MSI-FB-PB100 MSI-FB-PB100
+MSI XXX +MSI XXX

Figure 1 PROFIBUS gateway for the MSI XXX modules

Make sure that you always use the latest documentation.
This is available for download under www.leuze.com/controller/.

[— )
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2 Downloading the GSD file

1. The download link for the GSD file is available at
www.leuze.com/controller/.

2. Click on the GSD file.

3. Save the GSD file by clicking on "OK".

3 Controls and indicators of the
MSI-FB-PB100

Figure 2  Controls and indicators

1. Button
2. Status LEDs

a

Setting PROFIBUS address on the
MSI-FB-PB100

Press the button 1 (see Figure 2 on page 3) on the
MSI-FB-PB100 for approx. 3 seconds (until PWR LED
blinks with 2 Hz).

The LEDs (see Figure 2 on page 3) on the
MSI-FB-PB100 show the current PROFIBUS address
(preset value: 4).

Set the PROFIBUS address by pressing the button on
the MSI-FB-PB100 (see table).

Press the button on the MSI-FB-PB100 for six seconds
to accept the address.

After the address has been accepted, all LEDs briefly
illuminate.

° If no button is pressed for approx. 3 seconds, the
1 device returns to the standard operating mode.

PWR

LED code PB
DAT | ERR| BF | SF | address

I preset PB address

o|o|ojojo|(o|o|o

° The status LEDs are used to display the
1 PROFIBUS address while the address is
being set.

4 Example of addressing

CPU

S7...
4

/ L]

PROFIBUS address: 2

PROFIBUS address: 4

MSI-FB-PE101
=
@

Figure 3 Exemplary addressing

Interface address

Oo|o|(o|o|o|o|o|o|(o|o|Oofo]o|o|o|o
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6 INTERFACE system addressing 7 Integration into STEP 7

71 Creating a project with SIMATIC 300
1. Starting SIMATIC Manager

Please perform during initial startup!

[ J
1
1. Press the button (see Figure 2 on page 3) on the

MSI-FB-PB100 for approx. 12 seconds (until PWR LED -
blinks with 4 Hz). SIMATIC

2. After releasing the button, the SF LED blinks (if the Manager
SF LED does not illuminate alone, press the button Figure4 SIMATIC Manager icon
over and over until the SF LED illuminates alone).

3. Briefly press the confirm button on the MSI XXX. 2. Create a new project

4. Al LEDs on the MSI XXX illuminate briefly as a confir-
mation; then the PWR LED illuminates.

QSIMATIE Manager - [Test Alex2_281009 -- C:\Siemens',\Step7's7proj\Test_A_3]
BB File Edit Insert PLC Miew Options ‘Window Help
Chrl+Hh

5. Press the button on the MSI-FB-PB100 for approx. i
6 Seconds' E Open... Chrl+O
6. All status LEDs on the MSI XXX illuminate briefly one Open Version 1 Project...
time Close
7. The PWR LED and the DAT LED now illuminate on the HLEprolee; ’
MSI-FB-PB100 57 Memory Card e
' Memory Card File 3
: Save As... Chrl+5
o If no button is pressed for approx. 10 seconds, Fiqure 5 Creating a new proiect
1 the device returns to the standard operating 9 9 prol
mode. . . S L AR
3. Assign a project name and click "OK
° A project must exists on the MSI XXX before
1 interface system addressing. User projects | Librares | Muliprojects |
M ame | Storage path |4
° If there is still no communication via the Profibus B kofdai L:ASiemenshStep s 7profikgfdzui
1 during configuration, the BF LED and the SF LED BP57_MR_28082009_1 C:\Siemens\StepTsTpioihS 7_MA_1
continuously illuminate red. @S?_Prﬂ C:\Siemens\Step S 7prohS7_Prol
@S?_Prﬂ C:\Siemens\Step ™S 7prohS7_ProZ i
@ S7_Pra3 C:\Siemens\StepaprajhS 7_Pra3
@ S7_Prod C:\Siemens\StepaprajhS 7_Prod
@ S7_Prob C:\Siemens\Step7afpraj\S 7_Prab
EBT.-ML Aulmin CA T mmnmims ACham T aTmrmih Tommb Ml j

™ f:dd to current multiproject

Maarne: Type:
ITestploiect I Project = I
I F Librany

Storage location [path]:

IC:\Siemens\S tep s Fproj Browse. . |

Ok Cancel | Help |

Figure 6 Saving project name

Leuze electronic MSI-FB-PB100
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4. Select the appropriate CPU in the "Insert" menu point
under "Station".

QSIMATIE Manager - [Testproject -- C:hSiemens'Step 7 s Tproj, T

&5 File  Edit

PLC Wiew Options
1 SIMATIC 400 Station

Window  Help

Subnet g £
Prograrm 3 SIMATIC H Station
R — N 4 SIMATIC PiC Skation
m———y N 5 Other station
MF Softwate 2 o bless

7 PPC
Symbol Table
Texk Librarsy, r
External Saurce. ..

Figure 7 Selecting CPU

5. The selected CPU is inserted into your project.

QSIMHTIE Manager - [Testproject -- C:hSiemens'Step 7' s7proj', Testproj]
£p Fie Edt Insert PLC View Options ‘Window Help

Dlwl e e e =) R N _I_
[EE SIMATIC 30001)

Figure 8 Selected CPU

6. Open the context menu of the inserted CPU. Click on
"Open Object".

HSIMATIE Manager - [Testproject -- C:'\Siemens',Step7\s7proj', Testproj]

@F\IE Edit Insert PLC  Wiew Options Window Help
| | = RN B R E &1 [<NaFiter >

F: Hardwas

Ctrl+al+0

Cut Chrl+i

Copy Chrl+C

Paste (Chrl

Delete Del

PLC 4
Print 3
Rename Fz

Object Properties... Ak+Return

Figure 9  Opening object

7. The hardware configuration is displayed.

oni io =ioixi
T Soten C3k -t AC Yow Optors Whcon b eI
DR & sle| dblal @] 2wl
Tos | ]
jm«, I —

= B¢ PROFIBUS DP
4 PROFIRUS PA
@ ] SMATIC 300
& ] SMATIC 400
5 ] SIMATIC P Based Cornol 300/400
58, SMATIC PC Statn

4 . o

4= simatic 3s0n)

sm]l Designation |

[PROFIEUS DP slaves for SIMATIC 7. ﬂ
M7, and 7 (st reck)

Press F1to et Help. T =z

Figure 10 Hardware configuration

8. Close all application windows.

Figure 11 Hardware configuration

9. Open the "Options" menu and select the "Install New
GSD..." item.

E{;:Hw Config: Configuring hardware

Skationm PLC  Wiew | Options Help

Customize. ..

Chrl+-Alk+E

Edit Catalog Profile
Update Catalog

Ineball H Lind

AMpors SCatiorr ot .

Find in Service & Support...

Figure 12 Installing GSD file

10. Now load the GSD file downloaded in chapter 2.

1. If the "Installation was successful" message appears,
you can close the hardware editor.

Leuze electronic
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14. The Catalog window opens.

Install GSD Files B x|
Irestall GSD Files: [ from the directory =l [ =10l x|
=181
IC:\Dokumente und EinstellungentCCaXN\Deskiop Browse ...
S| at|ai]
Profile: lm
Install GSD File {13:4986) ] ﬂ %? PROFIBUS DP

\ia) Installation was completed successhully.

EM-PB-GATEWAY-IFS

Install | Show Log Select All Deszelect All

Help |

Figure 13 "Installation was successful" message

12. Open the context menu of the inserted CPU.
Click on "Open Object".

HSIMATIE Manager - [Testproject -- C:\Siemens'\ Step 7\ s7proj' Testproj]
%F\Ie Edit Insert PLC ‘iew Options Window Help

Figure 14 Opening object

13. Open the "View" menu and select "Catalog"

E-JL#:HW Config - [SIMATIC 300{1} {Configuration} -- Testproject]
E“] Station  Edit  Insert PLC | Yiew Options  Window Help

D[ 87| 4 |F|e dba| [o 2] 2 [[<NoFirer>
[ER=. N1 L Hardusare:
: C 200[1

Open Object Chrl+al+0 l
Cut Chrl
Copy Chrl4+C
Paste Chrl+
Delete Del
PLC 3
Print 3
Rename F2
Obiject Properties,.. Alk+Return

|3~ |5 & r?
rEss Cwerview. .. e
Filter 3
v Toolbar

v Status Bat

Update FS
Auto Arrange F4

Figure 15 Catalog selection

PROFIBUS-Pa

SIMATIC 300

SIMATIC 400

SIMATIC PC Based Control 3004400
B SIMATIC L Station

PROFIBUS-DF slaves for SIMATIC 57, H
M7, and C7 [distibuted rack] =

4

Figure 16 Catalog window

15. You must now insert the appropriate devices into your
project here.
7.2 Hardware configuration

1. Selectthe "SIMATIC 300" — "RACK 300" — "Rail" item
and insert it into your project.

~| Find: |

ﬁ:l= ﬂi.l=
Profile: I Standard LI
%? FROFIBEUS DP

= SIMATIC 200
BT 7
B+ CP-300

-l
SIMATIC 400
SIMATIC PC Based Control 3004400
-8, SIMATIC PC Station

14

Figure 17 Selecting rail
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2. Select the "SIMATIC 300" —»
"6ES7-315-2AF03-0AB0" —

into your project.

"CPU 315-2 DP" —

"V1.2" item and insert it

= | Find: I ﬁﬂ ﬁi.l=
FErofile: I Standard ;I
w— FROFIBUS DF I
-3 CP-300
Bl {:| CPU-300

Figure 18 Selecting CPU

{3 CPU 3130
{3 CPU 313C-2 0P
(I3 CPU 313C-2 PIP

{3 CPU 314C-2 PIP
-0 CPU 316
CFU 2152 DF

&l °F TS-2AF 00-0A8
-[8] GEST H5-2aF01-04E
-] sEST 315-28F02-008
{1 BES7 315-24F03-048

T ZHFE2-058
{2 BES7 315-2AF83-045
-[B sES7 15-28G10-048

£-{Z1] CPU 315F-2 DP

LT e e

3. The "Properties" window opens.

Click on "New" and assign the bus segment a name.

[Properties - PROFIBUS interface DP (R0/52.1)

General | Paramelers |

Address: E -

Subret

Order number

New.

Paee:
B

—

0 cruano

0 cruan2

3 CPUFI2IM
L cruzie

{0 cPuaI3

| 4 cruatae

{1 CPUFIIC20P
O cruTIIC2PP
L cruang

0 CRUFT4IFM
{0 crugtac2op
{1 CPUITC2PP
O cruas

{0 cPuFIs20P

i

g vio
g vi1
[ viz

{0 CRUFISF2DP
SER

Cancel Help

{0 CRUFIE2DF
£ cPuFIT2
{3 CPUFI72PN/DP

TTTTTTTTTC

0 crudTF2

3 tPU3IB2
0 cruET4

[BES7 315 2AF03-04B0 P
[werk memery 64 KEB; 0.3 ms/1000
instuctions: MP1+ DF connection

(DP master o DP slavel: mulier o

[Gha 4

[§ 6E57 3152400088
[§] sES7 31524701048
8] 6ES7 315-24F 02008
= (1 6ES7 3152703048

EEST 31524F 82048
1] BEST 91528FB3 048
EES7 1524GT00A8

0 CRUMT
£ B _';I
| —
=

Figure 19 Bus segment name

4. Select the "PROFIBUS-DP" —

es" — "Gateway" item.

Now drag the MSI-FB-PB100 into your project.

Eind |

FErofile: IStandard

-

= B PROFIBUS DF |
- Additional Field Devices |
170

M- {:I Compatible PROFIBUS DF Slaves
----- 0 CiR-Object

M- Cloged-Loop Contraller
M- Corfigured Stationg
B-Z1 DP VO slaves

B0 DPAAS

-0 DP/PA Link

#-{Z1 ENCODER

-3 ET 2008

[+ ET 200C

B-1 ET 200eco

-0 ET 200i5

B+ ET 2000

- ET 200M

B+ ET 200R

B+ ET 2005

-3 ET 200U

B0 ET 200

-Z0 Function Modules
- IDENT

B0 IPC

B0 NC

-0 Metwaork Components
®-] Sensoric

B
1

H- SIMaDYN
0.7 CIATIC

Figure 20 Selecting gateway

-

=

5. The "Properties" window opens.
Under "Address", you must select the address which
was configured in the MSI-FB-PB100 in chapter 4.

"Additional Field Devic-

General  Patameters |

Transmission rate: 1.5 Mbps

Address:

Subnet:

Properties - PROFIBUS interface EM-PB-GATEWAY-IFS

- riok netwiorked -

Drder number
BES7 315-2,

Properties.

De\ete

Cancel Help.

EE=

= Gateway

@ DF/DF Ca
@ DP/RS232
& ELAFBES
@ EMPBGA
& DP/DF Co
farc

{1 Compatible PR

I CR-Object

[ Closed-Loop Conirg
[ Configured Stations|
[ DP Y0 slaves

[0 DPAS-

[ DP/PA Link

[ EMCODER

[ ET 2008

[3 ET 200C

[ ET 20000

[ ET 2005

[ ET 2000

[ ET 200M

[ ET 200R

[ ET 2008

[ ET 2000

[ ET 200

[ Function Modules

I IDENT

£11Fc
fanc
{1 Network Compone

(1 Sensoric
-1 SIMADYN

Figure 21 Gateway properties
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6. You can now drag the necessary GSD data from the
Catalog window into your project under the
"MSI-FB-PB100" item (see chapter 9).

[flHW Config - [SIMATIC 300{1) {(Configuration) - Testproject]

@) Station Edit Inssrt PLC Wiew Options ‘Window Help

Dl(-|® %) S dn|aiaf [ =] 38 w2l |

PROFIEUS): DP master system (1]

4l |
| mp| sinaaTIC 30001)

Slot | Designation
UR

ROADF master system (1)

Figure 22 GSD data

8 Setting: byte order

1. Open the context menu of the MSI-FB-PB100 and
select "Object properties”.

2. Activate the "Parameter Assignment" tab.
*Mastersysham 1]

-

o]

properes-opsimve § ﬂ
General Parameter Assignment |
Parameters ‘ Walue :I
[£] OP Interrupt Mode | oPvD
(7] General DP parameters |
SHER

|-[£] 1Fs Application : ELR, EMM
-] Byte order Motarola j
I-[Z] Behaivar at Profibus errar M otarala
=] GUTPUT 1 controled by :
[Z] GUTPUT 2 controled by Prafibus
[Z] OUTPUT 3 controled by : Prafibus
[Z] OUTPUT 4 controled by : Prafibus
[Z] Real pawer [W1* 0.001) 1000
-] Reactive power [var](* 0.001) 1000
-[Z] Power [¥A](* 0.001) 1000
I-[£] voleage [¥]i* 0.001) 10000
2] Current [A10* 0.000001) 100000
-[Z] Switcheycles (* 0.000001) 1000000
I-[£] operatioon time [h](* 0.000001) 100000000 =
2] Energy [kwh]i* 0,000000001) 1000000
- [£] Userdsfined 1 (* 0,000001) 1000000 ~|

Figure 23 Setting of byte order

Cancel Help |

3. You can set the byte order of the transmitted data here
under "Device-specific parameters", item "Byte order".

9 Explanation of GSD data

° You can find a comprehensive description in the
L | |package insert of the MSI-FB-PB100 supplied
with the product.

You can download the package insert at www.leuze.com/
controller/.

9.1 GSD data for MSI-FB-PB100

MSI-FB-PB100

Universal module

Digital inputs, outputs

Gateway: Module state

Gateway: Channel State 1

Gateway: Channel State 2

Gateway: Channel State 3

Gateway: Channel State 4

IFS: Slave Error State 1

IFS: Peripherie State 1

Leuze electronic

MSI-FB-PB100
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9.2 GSD data for MSI 10x

MSI100 — Objects

MSI100 : Device

Interface

MSI100 : Safe IN w01

Safe inputs: 10 — 115

MSI100 : Safe IN w02

Safe inputs: 116 — 119

MSI100 : Safe OUT wO1

Safe outputs: O0 — O3

MSI100 : None Safe OUT w01

Message outputs: MO — M3 and external signals: EQO — EQ11

MSI100 : None Safe OUT w02

External signals: EQ12 — EQ15

MSI100 : PWR-LED

Diagnosis LED: PWR

MSI100 : ERR-LED

Diagnosis LED: ERR

9.3 GSD data for MSI 20x

MSI200 - Objects

MSI200 : Device

Interface

MSI200 : Safe IN w01

Safe inputs: 10 — [15

MSI200 : Safe IN w02

Safe inputs: 116 — 19

MSI200 : Safe OUT w01

Safe outputs: O0 — O3

MSI200: None Safe OUT w01

Message outputs: MO — M3 and external signals: EQ0 — EQ11

MSI200: None Safe OUT w02

External signals: EQ12 — EQ27

MSI200: None Safe OUT w03

External signals: EQ28 — EQ43

MSI200: None Safe OUT w04

External signals: EQ44 — EQ59

MSI200: None Safe OUT w05

External signals: EQ60 — EQ63

MSI200: Diag IN w01

Diagnosis LEDs: PWR, DATA, ERR and voltage supply terminal 24V/0V and
short circuit O0 — O3

MSI200: Slave1 — Diag IN w01

Diagnosis LEDs EM1: PWR, ERR

MSI200: Slave1 — Diag IN w02

Diagnosis EM1: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave2 — Diag IN w01

Diagnosis LEDs EM2: PWR, ERR

MSI200: Slave2 — Diag IN w02

Diagnosis EM2: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave3 — Diag IN w01

Diagnosis LEDs EM3: PWR, ERR

MSI200: Slave3 — Diag IN w02

Diagnosis EM3: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave4 — Diag IN w01

Diagnosis LEDs EM4: PWR, ERR

MSI200: Slave4 — Diag IN w02

Diagnosis EM4: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave5 — Diag IN w01

Diagnosis LEDs EM5: PWR, ERR

MSI200: Slave5 — Diag IN w02

Diagnosis EM5: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave6 — Diag IN w01

Diagnosis LEDs EM6: PWR, ERR

MSI200: Slave6 — Diag IN w02

Diagnosis EM6: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave7 — Diag IN w01

Diagnosis LEDs EM7: PWR, ERR

MSI200: Slave7 — Diag IN w02

Diagnosis EM7: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave8 — Diag IN w01

Diagnosis LEDs EM8: PWR, ERR

MSI200: Slave8 — Diag IN w02

Diagnosis EM8: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave9 — Diag IN w01

Diagnosis LEDs EM9: PWR, ERR

MSI200: Slave9 — Diag IN w02

Diagnosis EM9: voltage supply terminal 24V/0V and short circuit O0 — O3

MSI200: Slave10 — Diag IN w01

Diagnosis LEDs EM10: PWR, ERR

MSI200: Slave10 — Diag IN w02

Diagnosis EM10: voltage supply terminal 24V/0V and short circuit O0 — O3

Leuze electronic
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10 Example

The following modules are used in this example:
— SIMATIC S7-300
- MSI-FB-PB100

10.2 GSD values used

10.1 Hardware structure

CPU
# L
/ PROFIBUS address: 4
PROFIBUS address: 2
teos W I

MSI-FB-PB101
=
@

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘

Interface address

Figure 24 Hardware structure

Order no. / designation

=
o
o
ool
b
o]
=

Digital inputs, outputs

Inputs and outputs of the MSI-FB-PB100

MSI100 : Device Must be set
MSI100 : Safe IN w01 Display: safe inputs: 10 — 115
MSPEE MSI100 : Safe IN w02 Display: safe inputs: 116 — 119
C 1] MSI100 : Safe OUT w01 Display: safe outputs: O0 — O3
o — MSI100 : None Safe OUT w01 Display: message outputs: MO — M3

Leuze electronic

MSI-FB-PB100
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10.3 Monitoring variables

Config - [SIMATIC 300(1) {Configuration) - Testproject] Properties -DPstave =

E“] Skation  Edit Insert PLC Wiew Options ‘Window Help

General Parameter Assignment | Identification |

@I ﬂlﬂl EI %I ﬁl ‘ Parameters Walue
=]
eég DP Interrupt Mode DPYO
12 — PROFIBUS(1): DP master system (1] EE g::Ezlsgch;c'j;if;:ters
| IF3 Application : ELR, EMM
X2 oe J T —E Byte order : Inkel
3 -[£] Behaivar at Profibus error : Reset outputs
4 -[Z] QUTPUT 1 controled by Profibus
5 [Z] oUTPUT 2 controled by Profibus
B (] QUTPUT 3 controled by : Profibus
7 |-[E] QUTPUT 4 contraled by Profibus
g -(£] Real power [W]{ * 0,001 1000
3 [Z] Reactive power [var]{ * 0,001 ) 1000
[Z] Power [wAJ *0.001) 1000
10 (2] voltage [V * 0.001 ) 100
n |[Z] Current [A]* 0.001 ) i
’ ‘ [E] Switchoycles (* 1) 1
—Fﬂ Operatioon time []{ * 0,001 ) 1
P | | Cancel | Help
| o) EMPBGATEWAYFS Figure 26 Object properties of the MSI-FB-PB100
Slat | [3 Order Murnber / D esignation | Addrese | 0 Address Comment . .
1 .112 Digital inputs, outputs %6257 |256..257 e In th.e object properties of the MSI-FB-PB100, the.con-
31 3 |Ms000 Device 1 version factors of the measurement values are defined.
14 BE |ME| x3 Master Input 15..0 284,285
15 BE [MS] 33 Master Input 1916 286...287
16 BE |MS1 3 Master SafeOut 288..289
17 BB |MS| x4 Master UnSafeOut 290..291
18
19

Insertion possible

Figure 25 Opening context menu of the MSI-FB-PB100

Leuze electronic MSI-FB-PB100 11



